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ABSTRACT

The Fisher equation was originally intended to model the propagation of advantageous genes.
We use this reaction-diffusion equation equipped with non-local boundary conditions to
model the propagation of individuals across geographical maps. These boundary condition
account for a non-local "diffusion" across channels. The results represent the dispersal of
the Homo Sapiens across the globe. The discretisation is based on finite element methods.
Moreover, the Strang splitting method is employed to cope with the diffusion and reaction
term separately.
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Chapter One

Introduction

1.1 Origins of the Fisher-KPP Equation

In 1937, two articles were published concerning the spatial propagation of advantageous genes
in a population. The author of the first article was Fisher [4], who studied the propagation
of dominant genes in one spatial dimension. He modelled the proportion of the population
located at point x at time t possessing the dominant gene with u(t, x), and thus there holds
0 ≤ u ≤ 1. To take into account natural selection, he used Verhulst’s logistics equation

∂u

∂t
= λu(1− u), (1.1)

for λ ∈ R>0. Moreover, Fisher modelled the diffusion of the offspring of an individual with
a favourable gene in a neighbourhood of x by adding a diffusion term,

∂u

∂t
= λu(1− u) + c

∂2u

∂x2
. (1.2)

Fisher then showed the existence of infinitely many travelling wave solutions for (1.2), that
is solutions of the form u(t, x) = u(x− vt) satisfying

0 ≤ u(t, x) ≤ 1, lim
x→−∞

u(t, x) = 0, lim
x→∞

u(t, x) = 1, (1.3)

provided that v ≥ 2
√
λc. Thus, travelling waves of constant speed v along the x-axis connect

the steady state u = 1 of the advantageous gene with the state u = 0 lacking any such gene.
The second article was published by Kolmogorov, Petrovsky and Piskunov [8]. Simi-

larly, it concerned the propagation of dominant genes. Based on Mendelian genetics, they
considered

∂u

∂t
= f(u) + c

∂2u

∂x2
, (1.4)

where u represents again the density of favourable genes, and where f(u) satisfies

f(0) = 0 = f(1), f ′(0) > 0, (1.5)
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and for 0 < u < 1,
f(u) > 0, f ′(u) < f ′(0). (1.6)

Assuming that the initial condition satisfies

0 ≤ u(0, x) ≤ 1, (1.7)

as well as
u(0, x) = 0 ∀x < x1,

u(0, x) = 1 ∀x > x2 ≥ x1,
(1.8)

the authors proved that the gene propagates at constant speed v = 2
√
f ′(0)c. Furthermore,

under these assumptions on the initial condition, (1.4) admits a unique solution which fulfils
0 < u(t, x) < 1 for all (t, x) ∈ R × R≥0, and which converges towards a wave profile prop-
agating at finite speed v. Thereof, we may conclude that the initial gradient governs the
speed of propagation. It has been shown that for compactly supported initial datum, wave
fronts evolve to solutions of minimal speed of propagation [10].

Let me emphasise that in case of the Fisher’s equation (1.2), we have

f(u) = λu(1− u). (1.9)

Notice that this implies
f ′(u) = λ(1− 2u). (1.10)

Therefore we realise that for λ ∈ R>0,

f(0) = 0 = f(1), f ′(0) = λ > 0, (1.11)

and for 0 < u < 1,
f(u) > 0, f ′(u) = λ(1− 2u) < λ = f ′(0). (1.12)

Hence Fisher’s equation satisfies the conditions (1.5), (1.6). If we now further suppose that
(1.7) and (1.8) are fulfilled, there holds according to Kolmogorov, Petrovsky and Piskunov
[8] that there is a unique solution propagating at constant speed

v = 2
√
f ′(0)c = 2

√
λc. (1.13)

Consequently, the solutions propagate at finite speed.
On the other hand, we realise that in the case λ = 0, Fisher’s equation (1.2) coincides

with the heat equation, admitting infinite speed of propagation [1]. However, note that in
this case the assumption (1.5) is violated.
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In conclusion, in our case with constant or piecewise constant values for the diffusion
coefficient c, we anticipate solutions with finite speed of propagation. The succeeding nu-
merical experiments meet this expectation. In all simulations performed below aiming at the
exhibition of travelling wave solutions originating from compactly supported initial datum
on bounded domains, we observe numerically a finite speed of propagation, see section 5.1.

In two and three spatial dimensions, propagating wave fronts may evolve to some station-
ary states. Albeit these need not be unique, they usually possess some kind of symmetry.
Under the assumption that a stationary wave propagates along the x-axis, travelling wave
solutions read in the two-dimensional case for some x = (x1, x2) ∈ R2,

u(t,x) = u(x1 − V t, x2), (1.14)

where V is the velocity of the wave. In the two-dimensional case with two stationary states,
we may expect a reflection symmetry for the wave front with respect to its propagation
direction [2].

1.2 Earlier works on Population Dynamics

In 2017, W. P. Petersen et al. published a paper [14] on the numerical simulation of Fisher’s
equation on geographical maps based on a finite difference scheme, employing a Godunov-
type splitting. Following their main goal to model population dynamics, we discuss in the
sequel another approach based on finite element methods, where we employ the Strang
splitting method.

Our interests are drawn to study the evolution of our population density over space and
time. Since we want to model the dispersal of the Homo Sapiens on the globe, our time
horizon starts 200000 years ago, and ranges up to 15000 years ago. Moreover, our domain Ω

represents the earth’s surface. We model the humans’ evolution with the Fisher’s equation,
a special case of the Kolmogorov-Petrovsky-Piscounov equation.
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Chapter Two

Mathematical Derivation

2.1 Problem Formulation

Let Ω ⊂ R2 be a bounded domain, let T ∈ R≥0 be the final time. We consider a continuous
function u : [0, T ]× Ω→ R, representing the population density.

Assuming that u(t) ∈ C2(Ω), we have

∂u

∂t
= div( c(t,x) grad u) + λ (1− u

K(t,x)
) u in [0, T ]× Ω (2.1)

where c : [0, T ] × Ω → R denotes the diffusion coefficient, λ ∈ R>0 is a constant growth
factor, and K : [0, T ]× Ω→ R describes the carrying capacity.

Note that our domain Ω need not be connected. Indeed accounting for the various islands
over the globe, it is certain not to be. Thus it is of great importance to impose boundary
conditions describing properly the dispersal over straits, whenever two land territories are
close enough such that humans crossed the sea. Therefore we establish non-local boundary
conditions.

Let us consider a point on the boundary of Ω, x ∈ ∂Ω. Let L ∈ N denote the number
of connected components of our domain Ω. The boundary of Ω consists of all the curves
enclosing a single connected component. Thus we may number these curves Γi for i ∈ 1, ..., L

such that
L⋃
i=1

Γi = ∂Ω, where Γi∩Γj = ∅ for i 6= j. For any such x, we then have that x ∈ Γi

for some i ∈ 1, ..., L.
To account for the dispersal over the sea, we proceed as follows: let j : [0, T ] × Ω → Ω

model the flow of individuals in our domain. By Fourier’s Law, we find that

j(t,x) = −c(t,x) grad u in Ω. (2.2)

At the boundary, we impose the non-local flux condition

j(t,x) · n(x) =

∫
∂Ω

g(x,y) (u(t,x)− u(t,y)) dS(y), (2.3)

4



where n ∈ R2 denotes the outer normal vector, and where g : ∂Ω × ∂Ω → R is a kernel
function decaying with increasing distance between x and y. The intuition behind (2.3) is
that with a larger distance between two coastlines the difficulty of crossing the sea increases,
and thus the probability of the actual happening of such traversal diminishes. Moreover,
the gain of population on the point of arrival at ∂Ω evidently implies the loss of population
on Γi. Note that by taking all of the boundary ∂Ω into consideration as possible arrival
sites, we include the possibility of travelling along the coastline of departure Γi. Combining
equation (2.2) with (2.3), we obtain

− c(t,x) grad u · n(x) =

∫
∂Ω

g(x,y) (u(t,x)− u(t,y)) dS(y). (2.4)

Equation (2.4) connote the non-local boundary condition for our model.
Finally, starting with an initial population denoted by u0 : Ω → R, we obtain the

following model:

∂u

∂t
= div( c(t,x) grad u) + λ (1− u

K(t,x)
) u in Ω

−c(t,x) grad u · n(x) =

∫
∂Ω

g(x,y) (u(t,x)− u(t,y)) dS(y) on ∂Ω

u(0,x) = u0(x) in Ω

(2.5)

2.2 Variational Formulation

In the sequel we derive the weak formulation for (2.5). Let v ∈ C∞c (Ω) be a testing function.
Integrating (2.1) over Ω yields∫

Ω

∂u

∂t
(t,x) v(x) dx =

∫
Ω

div( c(t,x) grad u(t,x) v(x) dx

+

∫
Ω

λ (1− u(t,x)

K(t,x)
) u(t,x) v(x) dx

= −
∫

Ω

c(t,x) grad u(t,x) · grad v(x) dx

+

∫
∂Ω

c(t,x) grad u(t,x) · n(x) v(x) dS(x) +

∫
Ω

λ (1− u(t,x)

K(t,x)
) u(t,x) v(x) dx

= −
∫

Ω

c(t,x) grad u(t,x) · grad v(x) dx

−
∫
∂Ω

∫
∂Ω

g(x,y) (u(t,x)− u(t,y)) v(x) dS(y)dS(x)

+

∫
Ω

λ (1− u(t,x)

K(t,x)
) u(t,x) v(x) dx
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where we have used Green’s first formula [7] and the non-local boundary conditions of equa-
tion (2.5). Choosing suitable function spaces leads us to the following variational formulation:

We seek [0, T ] 3 t→ u(t) ∈ H1(Ω) satisfying∫
Ω

∂u

∂t
(t,x) v(x) dx +

∫
Ω

c(t,x) grad u(t,x) · grad v(x) dx

+

∫
∂Ω

∫
∂Ω

g(x,y) (u(t,x)− u(t,y)) v(x) dS(y)dS(x)

−
∫

Ω

λ (1− u(t,x)

K(t,x)
) u(t,x) v(x) dx = 0, ∀v ∈ H1(Ω)

(2.6)

with u(0,x) = u0(x) for x ∈ Ω.
Let u, v ∈ H1(Ω). Let us introduce bilinear functionals m, a, b : H1(Ω) × H1(Ω) → R

with

m(
∂u

∂t
(t), v) :=

∫
Ω

∂u

∂t
(t,x) v(x) dx =

∂

∂t

∫
Ω

u(t,x) v(x) dx =
∂

∂t
m(u(t), v), (2.7)

a(u(t), v) :=

∫
Ω

c(t,x) grad u(t,x) · grad v(x) dx, (2.8)

b(u(t), v) :=

∫
∂Ω

∫
∂Ω

g(x,y) (u(t,x)− u(t,y)) v(x) dS(y)dS(x), (2.9)

and finally for the non-linear term, we write r : H1(Ω) × H1(Ω) → R, a mapping linear in
its second argument, defined as

r(u(t); v) :=

∫
Ω

λ (1− u(t,x)

K(t,x)
) u(t,x) v(x) dx. (2.10)

With these notations, we arrive at the following formulation equivalent to equation (2.6):
we seek [0, T ] 3 t→ u(t) ∈ H1(Ω) satisfying

∂

∂t
m(u(t), v) + a(u(t), v) + b(u(t), v)− r(u(t); v) = 0, ∀v ∈ H1(Ω)

u(0) = u0 ∈ H1(Ω)
(2.11)
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Chapter Three

Discretisation: Method of Lines

3.1 Galerkin Discretisation

We pursue a method of lines approach [7], that is we first proceed with a spatial semi-
discretisation for equation (2.11).

The spatial Galerkin semi-discretisation relies on linear Lagrangian finite elements on
a triangular mesh M of Ω with the lowest-order Lagrangian finite element space S0

1 (M)

using a polygonal approximation of the boundary. In a first step, we replace our infinite-
dimensional Hilbert space H1(Ω) =: V0 with a finite dimensional subspace V0,h ⊂ V0. Thus,
we seek [0, T ] 3 t→ uh(t) ∈ V0,h satisfying

∂

∂t
m(uh(t), v) + a(uh(t), v) + b(uh(t), v)− r(uh(t); v) = 0, ∀v ∈ V0,h

uh(0) = u0,h ∈ V0,h

(3.1)

where u0,h ∈ V0,h represents the projection of u0 ∈ V0 onto V0,h = S0
1 (M).

As a second step, we choose an ordered basis Bh = {b1
h, ..., b

N
h }, where N := dim(V0,h),

such that V0,h = span{Bh}. Then we may expand uh, vh ∈ V0,h in terms of this basis functions
as uh(t) =

∑N
i=1 µi(t)b

i
h and vh =

∑N
j=1 νjb

j
h, where µi, νj ∈ R for i, j ∈ {1, ..., N}. Inserting

the corresponding expansions into equation (3.1) gives

∂

∂t
m(

N∑
i=1

µi(t)b
i
h,

N∑
j=1

νjb
j
h) + a(

N∑
i=1

µi(t)b
i
h,

N∑
j=1

νjb
j
h) + b(

N∑
i=1

µi(t)b
i
h,

N∑
j=1

νjb
j
h)

−r(
N∑
i=1

µi(t)b
i
h;

N∑
j=1

νjb
j
h) = 0, ∀νj ∈ R, j ∈ {1, ..., N}.

Equivalently,
N∑
i=1

N∑
j=1

νj (
∂

∂t
m(µi(t)b

i
h, b

j
h) + a(µi(t)b

i
h, b

j
h) + b(µi(t)b

i
h, b

j
h)− r(

N∑
l=1

µl(t)b
l
h; b

j
h) ) = 0,

∀νj ∈ R, j ∈ {1, ..., N}.
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Using Lemma 2.2.2.3 in [7], we find
N∑
i=1

(
∂µi
∂t

(t)m(bih, b
j
h)+µi(t)a(bih, b

j
h)+µi(t)b(b

i
h, b

j
h)−r(

N∑
l=1

µl(t)b
l
h; b

j
h) ) = 0, j ∈ {1, ..., N}.

Thus we seek [0, T ] 3 t→ µi(t) ∈ R, i ∈ {1, ..., N} satisfying

N∑
i=1

(
∂µi
∂t

(t)m(bih, b
j
h) + µi(t)a(bih, b

j
h) + µi(t)b(b

i
h, b

j
h)− r(

N∑
l=1

µl(t)b
l
h; b

j
h) ) = 0,

j ∈ {1, ..., N}
N∑
i=1

µi(0)bih = u0,h ∈ V0,h

Let us now introduce suitable Galerkin matrices M, A, B ∈ RN,N , where

M := [m(bih, b
j
h)]

N
i,j=1 (3.2)

A := [a(bih, b
j
h)]

N
i,j=1 (3.3)

B := [b(bih, b
j
h)]

N
i,j=1 (3.4)

These matrices will be assembled from the entries of the local element matrices on the
reference triangle, see section 4.2.2 below. Let µ := (µ1, µ2, ..., µN)T ∈ RN . For the non-
linear term write ρ : [0, T ]× RN → RN with

ρ(t,µ(t)) = [r(
N∑
l=1

µl(t)b
l
h; b

j
h)]

N
j=1. (3.5)

We then seek [0, T ] 3 t→ µ(t) ∈ RN satisfyingM{∂µ
∂t

(t)}+ Aµ(t) + Bµ(t)− ρ(t,µ(t)) = 0

µ(0) = µ0

(3.6)

where µ0 is the coefficient vector for the projection of u0 onto V0,h. We can recover the
discrete solution with uh =

∑N
i=1 µi(t)b

i
h.

Let me remark that by means of suitable numerical quadrature it is often possible to
obtain diagonal mass matrices, a trick called mass lumping [7]. In our case, we will make
use of mass lumping (see Remark 6.3.4.18 in [7]) based on the composite trapezoidal rule,
(2.3.3.8) in [7]. This allows the efficient computation of the inverse of the mass matrix M in
(3.6).

We have thus obtained a semi-discrete evolution problem for the coefficient vector µ ∈
RN . We acquire the full discretisation for equation (3.6) by employing a suitable time
stepping method.
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3.2 Strang Splitting Method

We apply the Strang splitting method [6] to solve the ordinary differential equation (3.6).
To this end, first note that since the bilinear form m in (2.7) is symmetric and positive

definite, we have that M is invertible [7]. Hence we may rewrite (3.6) as
∂µ

∂t
(t) = f(t,µ) + g(t,µ)

µ(0) = µ0

(3.7)

where f(t,µ) := −M−1(A+B) µ(t), and g(t,µ) := M−1ρ(t,µ(t)). Splitting equation (3.7)
into two parts, ∂µ

∂t
(t) = f(t,µ) and ∂µ

∂t
(t) = g(t,µ), allows to solve each part separately.

Consider the following mappings for fixed t ∈ [0, T ]:

Φt
f :

{
RN → RN

µ0 → µ(t)
(3.8)

and

Φt
g :

{
RN → RN

µ0 → µ(t)
(3.9)

corresponding to ∂µ
∂t

(t) = f(t,µ) and ∂µ
∂t

(t) = g(t,µ), respectively, with appropriate initial
condition µ(0) = µ0. These are well-defined mappings of the state space into itself, see [6].
We can now define evolution operators for each part:

Φf :

{
[0, T ]× RN → RN

(t,µ0)→ Φt
f (µ0) := µ(t)

(3.10)

Φg :

{
[0, T ]× RN → RN

(t,µ0)→ Φt
g(µ0) := µ(t)

(3.11)

Then we find that ∂Φf

∂t
(t,µ) = f(t,Φt

f (µ)), as well as ∂Φg

∂t
(t,µ) = g(t,Φt

g(µ)).
We proceed by introducing an equidistant temporal mesh with nodes 0 = t0 < t1 < ... <

tM−1 < tM = T, M ∈ N. Let τ := t1 − t0 be the step size. This allows to discretise the
mappings (3.8), (3.9), as well as the evolution operators (3.10) and (3.11). In particular we
define the discrete mapping

Ψτ := Φ
τ/2
f ◦Φ

τ
g ◦Φ

τ/2
f . (3.12)

This constitutes the Strang splitting method.
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3.2.1 Diffusion Term

Let us first consider the pure diffusion problem, represented by ∂µ
∂t

(t) = f(t,µ) with initial
condition µ(0) = µ0. We compute a sequence (µ(k))Mk=0 of approximations
µ(k) ≈ µ(tk) for k ∈ {1, ...,M} on the nodes of the temporal mesh, according to

µ(0) := µ0

µ(k) := Ψtk
f (µ(k−1)), k ∈ {1, ...,M}

(3.13)

where Ψtk
f for k ∈ 1, ...,M is the discretised mapping (3.8).

We require an L(π)-stable implicit 2-stage Runge-Kutta method for the diffusion term.
We choose the SDIRK-2 method, which is described by the following Butcher Tableau:

c A

bT
=̂

ξ ξ 0

1 1− ξ ξ

1− ξ ξ

where ξ := 1 − 1
2

√
2. Indeed, the SDIRK-2 method is L(π)-stable according to Definition

6.2.7.48 in [7]. I reprint this definition below.

Definition 1: L(π)-stability A Runge-Kutta single-step method satisfying
limj→∞(S(z))jy0 = 0, ∀y0 ∈ R,∀z ∈ R<0 is called L(π)-stable, if its stability function
S(z) satisfies

(i) |S(z)| < 1, ∀z < 0, and

(ii) lim
z→−∞

S(z) = 0.

Claim 1: The SDIRK-2 method is L(π)-stable.

Proof. To verify Claim 1, we inspect the stability function S(z) for the SDIRK-2 method.
The stability function is derived by applying the method to the scalar, linear test equation

ẏ(t) = λy(t), λ ∈ R.

The solution can be written as
yk+1 = S(z)yk

where S : C → R is the stability function for the method, and z := λτ with step size τ . In
our case, we find for the increments k1, k2 ∈ R

k1 = λ(yk + τξk1),

k2 = λ(yk + τ(1− ξ)k1 + ξk2).
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Thus, we obtain

k1 =
λ

1− λτξ
yk,

k2 =
λ(1 + τ(1− ξ)λ)

(1− λτξ)2
yk.

Furthermore, we find for the solution

yk+1 = yk + τ(1− ξ)k1 + τξk2

= yk + τ(1− ξ) λ

1− λτξ
yk + τξ

λ(1 + τ(1− ξ)λ)

(1− λτξ)2
yk

= (1 +
z(1− ξ)
1− ξz

+
ξz + ξz2(1− ξ)

(1− ξz)2
)yk

=
1 + (1− 2ξ)z

(1− ξz)2︸ ︷︷ ︸
=: S(z)

yk.

That is, we find

S(z) =
1 + (1− 2ξ)z

1− 2ξz + ξ2z2
, z ∈ C− := {z ∈ C|<(z) < 0}. (3.14)

Clearly, we see that (ii) in Def. 1 is satisfied. Moreover, to verify (i), we consider S on the
imaginary axis.

|S(iy)|2 =
|1 + (1− 2ξ)iy|2

|(1− ξiy)|4
=

1− (1− 2ξ)2y2

(1 + (ξy)2)2
=

1− 2ξ2y2

1 + 2ξ2y2 + ξ4y4
≤ 1, y ∈ R,

where we have used for the last equality the definition of ξ. Since the only pole (z = 1
ξ
) of

the stability function lies in the positive half plane of C, the function S is holomorphic in the
negative half plane. Furthermore, S is bounded by 1 on the imaginary axis, which coincides
with the boundary of the negative half plane. By the maximum principle for holomorphic
functions [11], S is bounded on the entire negative half plane by 1. Thus (i) in Def. 1 is
satisfied, and therewith, the SDIRK-2 method is L(π)-stable.

We now consider the SDIRK-2 method for the diffusive term. Following the Butcher
Tableau, we compute µ(k) from µ(k−1) for k ∈ {1, ...,M} by solving a linear system of
equations.

We seek k1,k2 ∈ RN such that

Mk1 + τξ(A + B)k1 = −(A + B)µ(k−1)

Mk2 + τ(1− ξ)(A + B)k1 + τξ(A + B)k2 = −(A + B)µ(k−1)
(3.15)

Then we can recover the solution with

µ(k) = Ψτ
f (µ

(k−1)) = µ(k−1) + τ(1− ξ)k1 + τξk2. (3.16)
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3.2.2 Reaction Term

For the reaction term, being represented by ∂µ
∂t

(t) = g(t,µ) with initial condition µ(0) = µ0,
we can implement the exact evolution operator, for the analytical solution of this ordinary
differential equation is known. Thus the discrete evolution operator coincides with the exact
evolution.

To derive the analytical solution of the ordinary differential equation arising from the
reaction term, we solve the purely local logistics ordinary differential equation

∂u

∂t
= λ (1− u

K(t,x)
) u in [T0, T1]× Ω,

u(T0,x) = u0(x) in Ω,

(3.17)

where R≥0 3 T0 < T1 < ∞. Note that λ is constant. Moreover, we may assume that the
carrying capacity is constant over the time interval [T0, T1], since in the end, we let our
solution evolve over several time intervals, in each of which the carrying capacity is constant
in time.

We first divide (3.17) by (1− u
K

) u, where in the sequel we simply write K for K(t,x) =

K(x), ∀(t,x) in [T0, T1]× Ω. Then using differentials for the partial derivatives we obtain

1

(1− u
K

) u

du
dt

= λ. (3.18)

Equivalently, we can write

1− u
K

+ u
K

(1− u
K

) u

du
dt

= (
1

u
+

1

K − u
)
du
dt

= λ. (3.19)

Hence we obtain
(
1

u
+

1

K − u
)du = λdt, (3.20)

which yields by integration

ln (u)− ln (K − u) = λt+ C0, (3.21)

with integration constant C0 ∈ R. Thus we find

u

K − u
= Ceλt, (3.22)

with C = eC0 . Finally, by properly rearranging we have

u =
CKeλt

1 + Ceλt
. (3.23)
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We determine the constant C with the initial condition,

u =
u0Ke

λt

K + u0(eλt − eλT0)
=

K

1 + (Ku−1
0 − eλT0)e−λt

. (3.24)

Using (3.24) for fixed t ∈ [0, T ], the mapping for the evolution operator reads

For every component of µ : Φt
g(µ) =

K

1 + (Kµ−1
0 − 1)e−λt

, (3.25)

where K = K(t,x) is the space dependent carrying capacity, constant over some finite time
horizon. Let me remark that we may partition the total time interval [0, T ] into several
time slots [Tj−1, Tj], j ∈ {1, ..., J}, J ∈ N such that Tj−1 < Tj, j ∈ {1, ..., J}, T0 = 0 and
TJ = T . Then K shall be constant in time in each time slot [Tj−1, Tj] for j ∈ {1, ..., J}. Note
that the locality of (3.17) in the finite element setting is preserved due to the employed mass
lumping, see section 3.1 above.
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Chapter Four

Implementation

In this chapter, I outline details of the implementation. In particular, note that I have made
use of the finite element library LehrFEM++ [9]. I oriented the choice of parameters on a
general notion of the settlements of the Homo Sapiens, ranging from 200000 years ago up
to 15000 years ago, see [17]. Please note that information from pre-historic times is sparse,
impeding highly accurate parameters.

4.1 Mesh Generation

First of all, I have generated a triangulation for our domain Ω, which, in our case of popula-
tion dispersal, represents the earth’s surface. The succeeding data flow diagram, figure 4.1,
summarises the procedure of generating a mesh file for our domain Ω.

Figure 4.1 Data flow diagram depicting the main steps to generate a triangulation of the earth’s
surface.

4.1.1 Raw data

In a first step, I obtained data for the earth’s coastlines from a geographical database, main-
tained by the University of Hawai’i together with a governmental geosciences lab, the national
oceanic and atmospheric administration [16]. The database includes a high-resolution data
set of the global shorelines. Moreover, I made use of a data base of land and sea-floor
elevations [12]. This was needed to extract the contour lines of the coastlines.
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4.1.2 QGIS

Subsequently, I imported this data into the geographic information system QGIS [15] via
Layer → Layer hinzufügen → Vektorlayer hinzufügen. I selected the path to the
data set with full resolution (GSHHS_f_L1.shp) from [16]. Furthermore, I added the
data base of land and sea-floor elevations (ETOPO1_Ice_g_gmt4.grd) from [12] via Layer
→ Layer hinzufügen → Rasterlayer hinzufügen. I then extracted the contour of the
coastlines, by selecting Raster → Extraktion → Kontur. Then there is the need of
specifying the correct input layer (ETOPO1_Ice_g_gmt4.grd) and there is the option to
save the output into a file. Also, I had to specify an additional command line argument,
-fl "-200". This yields the extracted coastlines. Note that I moved the coastlines of
the continents Europe, Africa and Australia to the left of America via Bearbeiten →
Objekt(e) verschieben. Finally, I selected all coastlines and merged them via Bearbeiten
→ Gewählte Objekte verschmelzen. Therewith, I have now extracted the coordinates
from the nodes of the shorelines.

Note that QGIS allows to install a plug-in to generate .geo-files from given input data.
This is the main reason why I have been working with QGIS. With this plug-in I was able
to select Erweiterungen → Gmsh → Generate a Gmsh geometry file. I now selected the
output file of the extracted shoreline, and then via Generate geometry file, I obtained a
.geo-file with the coordinates of the nodes on all coastlines.

4.1.3 Gmsh

Consequently, I imported the resulting .geo-file into Gmsh [5]. It lists all point coordinates
from nodes on the coastline. I connect these nodes by directly modifying the .geo-file: I add
Spline(IL+i) = {...} where I list in curly brackets all the nodes to be connected. Note
that IL stands for the splines, whereas i simply denotes the numbering of all splines. Then I
add a line loop Line Loop(ILL+i) = {IL+i}, where ILL represents the line loops. Finally, I
add the surfaces, Plane Surface(IS+i) = {ILL+i} with IS standing for the plane surfaces.
Note that large seas inside a surface can be explicitly denoted as "holes" in the surface, by
listing the corresponding line loop number denoting the surface of the "hole" behind the
number of the line loop representing the surrounding surface. Furthermore, it is crucial to
define the mesh size by adding these two succeeding lines on top of the .geo-file,

Mesh.CharacteristicLengthMin = 2;
Mesh.CharacteristicLengthMax = 2;

for otherwise, the resulting triangulation may be too coarse to properly respect the bound-
aries.
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Now I can open this modified .geo-file in Gmsh and select Mesh → 2D. This generates a
two-dimensional mesh, stored in a .msh-file. Note that the number of point coordinates on
the shoreline amounts to 340125. Therein are included all islands of reasonable size.

4.2 LehrFEM++

As a next step, I realised the population dispersal over the triangulated surface based on
the mathematical model. The implementation heavily relies on the finite element library
LehrFEM++ [9].

4.2.1 Input-Output Reader

In this library, there is a built-in reader to gather the information for the spatial mesh.
This reader extracts all necessary information from the .msh-file. The number of degrees of
freedoms in the final implementation amounts to 15463. Clearly, this implies that not every
node on the boundary is considered in the final mesh. This could be remedied by refining
the mesh size.

4.2.2 Galerkin Matrices

In the sequel, I discuss the detailed implementation of the Galerkin matrices defined in
equations (3.2), (3.3), (3.4).

For the matrix M ∈ RN,N defined in (3.2), we have

M := [m(bih, b
j
h)]

N
i,j=1 = [

∫
Ω

bih(t,x) bjh(x) dx ]Ni,j=1. (4.1)

This is the standard mass matrix (Remark 2.2.2.5 in [7]), and thus, I used the LehrFEM++
function ReactionDiffusionElementMatrixProvider for its assembly.

Furthermore, for the matrix A ∈ RN,N defined in (3.3), we find

A := [a(bih, b
j
h)]

N
i,j=1 = [

∫
Ω

c(t,x) grad bih(t,x) · grad bjh(x) dx ]Ni,j=1, (4.2)

with diffusion coefficient c : [0, T ] × Ω → R. Again, we are left with a standard Galerkin
matrix, the stiffness matrix (Remark 2.2.2.5 in [7]). Thus I again made use of Reaction-
DiffusionElementMatrixProvider for assembling A.

Finally, for B ∈ RN,N the discussion will be more elaborate. By definition, we obtain

B := [b(bih, b
j
h)]

N
i,j=1 = [

∫
∂Ω

∫
∂Ω

g(x,y) (bih(t,x)− bih(t,y)) bjh(x) dS(y)dS(x) ]Ni,j=1. (4.3)
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We proceed by considering the two terms separately. For i, j ∈ {1, ..., N} we have

Bi,j =

∫
∂Ω

∫
∂Ω

g(x,y) bih(t,x) bjh(x) dS(y)dS(x)

−
∫
∂Ω

∫
∂Ω

g(x,y) bih(t,y) bjh(x) dS(y)dS(x)

=

∫
∂Ω

∫
∂Ω

g(x,y) dS(y) bih(t,x) bjh(x) dS(x)

−
∫
∂Ω

∫
∂Ω

g(x,y) bih(t,y) dS(y) bjh(x) dS(x)

For the first integral, let us introduce the function h1 : ∂Ω→ R, with

h1(x) =

∫
∂Ω

g(x,y) dS(y). (4.4)

For the second term, we introduce hi2 : [0, T ]× ∂Ω→ R, i ∈ {1, ..., N}, satisfying

hi2(t,x) =

∫
∂Ω

g(x,y) bih(t,y) dS(y), i ∈ {1, ..., N}. (4.5)

Then we obtain for i, j ∈ {1, ..., N},

Bi,j =

∫
∂Ω

∫
∂Ω

g(x,y) dS(y)︸ ︷︷ ︸
=: h1(x)

bih(t,x) bjh(x) dS(x)

−
∫
∂Ω

∫
∂Ω

g(x,y) bih(t,y) dS(y)︸ ︷︷ ︸
=: hi2(t,x)

bjh(x) dS(x)

=

∫
∂Ω

h1(x) bih(t,x) bjh(x) dS(x)−
∫
∂Ω

hi2(t,x) bjh(x) dS(x)

Now we observe that the first term corresponds to a standard mass matrix on the boundary,
i.e. a mass edge matrix (Example 2.7.4.37 in [7]), with function handle h1. Thus the
implementation of theMassEdgeMatrixProvider in LehrFEM++ suits the required form.
The implementation of h1 requires the quadrature over ∂Ω. We use the EdgeMidpointRule
of third order for the concerned triangles.

The second integral demands a slightly more intricate treatment. We observe that it is
of the form of a load vector (Remark 2.4.6.7 in [7]) on the boundary with function handle
hi2, i ∈ {1, ..., N}. Hence we may use LehrFEM++’s ScalarLoadEdgeVectorProvider.
What concerns the function handle hi2, i ∈ {1, ..., N}, we identify again the form of a load
vector, where, for fixed x ∈ ∂Ω, we have the coefficient g depending on y ∈ ∂Ω. This implies
the use of ScalarLoadEdgeVectorProvider one more time.

The system of equations (3.15) was solved with the sparse matrix solver from the header-
only library Eigen [3].
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4.2.3 Visualisation

Finally, I used the VTK-writer class from LehrFEM++, to write the results into a VTK-file,
which in turn I imported into ParaView [13] in order to visualise the results.
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Chapter Five

Model Problem

In this chapter, I discuss the simulation of equation (2.5) on simplified domains, with the aim
to exhibit nice travelling wave solution as well as analysing the convergence of our numerical
scheme. In the first section, we focus on travelling wave fronts.

5.1 Travelling Wave Solutions

Let me refer to section 1.1 for a discussion on travelling wave solutions. The exhibition of
travelling wave fronts is taking place on three model domains.

Our first model domain is a ball of radius 0.5 around the point y = ( 0.5
0.5 ),

Ω̃1 := B0.5(( 0.5
0.5 )) = {x ∈ R2|‖x− ( 0.5

0.5 ) ‖ < 0.5}. (5.1)

The mesh M1 for Ω̃1 is depicted in figure 5.1. We set the diffusion coefficient c and the

Figure 5.1 Triangular mesh M̃1 of Ω̃1 generated with Gmsh [5].

growth factor λ to be constant. We choose a constant carrying capacity K. Furthermore,
we consider homogeneous Neumann boundary conditions.

In a first step, the initial condition is represented by one point load with value 0.001

located at ( 1
0.5 ). This setting yields clearly visible travelling wave fronts, originating from

the initial condition, see figure 5.2.
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(a) Solution after M = 100 time steps. (b) Solution after M = 200 time steps.

(c) Solution after M = 300 time steps. (d) Solution after M = 400 time steps.

Figure 5.2 Solution vector with initial condition represented by one point load visualised with
ParaView [13] on mesh with N = 3581 degrees of freedom.

In a second step, we leave all parameters unchanged, except for the initial condition,
which is now represented by an additional point load, the first being located at ( 1

0.5 ), the
second located at ( 0.5

1 ), both of value 0.0005. In this case we obtain again nice travelling
wave fronts, originating from both sources, and superimposing one another as time evolves,
see figure 5.3. Note that the wave originates from a compactly supported initial datum.

In both cases, we observe a good approximation of a wave front evolving with a finite
speed of propagation. Admittedly, we must behold that in the frame of the Strang splitting,
the first half time step coincides with the solution of the heat equation. Since the heat
equation admits infinite speed of propagation, we expect that after this first half time step,
the solution immediately attains a value arbitrarily close to zero, but non-zero, on the whole
domain. This can be noticed in figure 5.10, where we can read off the values of the solution
vector on the domain. There is no area where the solution is zero; instead the areas not yet
populated carry values very close to zero, namely 7.1 · 10−6. The finite propagation speed
arises due to the non-linearity. Indeed, we observe that the wave front propagates for further
time steps with finite speed. Accordingly, the numerical results approximate the finite speed
of propagation.

Secondly, we consider three circles, at a positive distance from each other. Concretely,
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(a) Solution after M = 100 time steps. (b) Solution after M = 200 time steps.

(c) Solution after M = 300 time steps. (d) Solution after M = 400 time steps.

Figure 5.3 Solution vector with initial condition represented by two point loads visualised with
ParaView [13] on mesh with N = 3581 degrees of freedom.

we set
Ω̃2 := B0.25(( 0

0 )) ∪B0.5(( 2
0 )) ∪B0.5(( 0

2 )). (5.2)

On this domain we aim to study the influence of the non-local boundary conditions (2.4)
on the travelling wave solution. The mesh M̃2 is illustrated in figure 5.4. We set the
parameters as follows: we choose a constant diffusion coefficient c and growth factor λ. We
set our carrying capacity K constant as well. We start with an initial population on one
circle, represented by one point load of 0.00008, such that the wave front originates from
this source.

In a first step, we impose homogenous Neumann boundary conditions. This yields wave
fronts evolving in a single circle only, see figure 5.5. Again, the wave fronts propagate with
finite speed.

In a second step, we ascertain non-local boundary conditions (2.4). The kernel is chosen
as

g1(x,y) :=
1

1 + ‖x− y‖2
. (5.3)

Notice that (5.3) is a slowly decaying function kernel. Note also that in this case, the kernel
attributes a non-trivial value on all of the boundary ∂Ω2. With this choice, we observe that
all circles are hit by the wave fronts, see figure 5.6.
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Figure 5.4 Triangular mesh M̃2 of Ω̃2 generated with Gmsh [5].

In a third step, we aim at further restricting the kernel. We set it to

g2(x,y) :=

 1
1+‖x−y‖2 , if ‖x− y‖ ≤ 1.75,

0, elsewhise.
(5.4)

Let me recall the domain Ω̃2. Starting from the small ball B0.25(( 0
0 )), we realise that the

upper bound ‖x− y‖ ≤ 1.75 in (5.4) does not reach all of ∂Ω̃2. However, we also note that
an upper bound does not restrict the wave fronts from evolving along the boundaries, and
thus, we still expect all of the boundary to be affected by the non-local boundary conditions.
Indeed, the results in figure 5.7 qualitatively coincide with those in figure 5.6.

Now, in a final step, we may try to confine the influence of the kernel by adding a lower
bound. Consider

g3(x,y) :=

 1
1+‖x−y‖2 , if 1.25 ≤ ‖x− y‖ ≤ 1.75,

0, elsewhise.
(5.5)

In compliance with Ω2, we note that the upper bound assures that the two balls, B0.5(( 2
0 ))

and B0.5(( 0
2 )), will be affected by the non-local boundary conditions. Nonetheless, the lower

bound prevents the wave fronts to propagate along the boundaries, see figure 5.8.
As a final domain, we set Ω̃3 to two arbitrarily shaped islands, whose boundaries are

at a positive distance from each other. Figure 5.9 presents the triangular mesh M̃3 for Ω̃3

with 6474 degrees of freedom. In this case, the diffusion coefficient and the growth rate are
chosen to be constant. The carrying capacity is constant as well. The initial condition is set
to a point load having value 0.3 on the left lower corner of the right island. The decaying
function kernel for the boundary conditions is chosen as in (5.3).
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(a) Solution after M = 100 time steps.

(b) Solution after M = 200 time steps.

(c) Solution after M = 300 time steps.

(d) Solution after M = 400 time steps.

Figure 5.5 Solution vector with homogeneous Neumann boundary conditions visualised with
ParaView [13] on M̃2. 23



(a) Solution after M = 100 time steps.

(b) Solution after M = 200 time steps.

(c) Solution after M = 300 time steps.

(d) Solution after M = 400 time steps.

Figure 5.6 Solution vector with non-local boundary conditions using the kernel g1 visualised
with ParaView [13] on M̃2.
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(a) Solution after M = 100 time steps.

(b) Solution after M = 200 time steps.

(c) Solution after M = 300 time steps.

(d) Solution after M = 400 time steps.

Figure 5.7 Solution vector with non-local boundary conditions using the kernel g2 visualised
with ParaView [13] on M̃2.

25



(a) Solution after M = 100 time steps.

(b) Solution after M = 200 time steps.

(c) Solution after M = 300 time steps.

(d) Solution after M = 400 time steps.

Figure 5.8 Solution vector with non-local boundary conditions using the kernel g3 visualised
with ParaView [13] on M̃2.
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Figure 5.9 Triangular mesh M̃3 of Ω̃3 generated with Gmsh [5].

In this setting, we observe in figure 5.10 the travelling wave fronts propagating with finite
speed on our model domain Ω̃3.

As a final experiment, we set the diffusion coefficient to a very small value, concretely
c = 0.0625. Otherwise, we consider the same setting as above for figure 5.10; except for the
growth factor λ, which we slightly decrease in order to balance the significant reduction of
the diffusion coefficient. We have in mind to visualise the case where the non-local boundary
conditions render the diffusion over the sea more attractive than the diffusion on land. Thus
we would expect an accumulation of the solution on the boundaries ∂Ω̃3. Let me refer to
figure 5.11 which meets our expectancy. We conceive the initial datum on one island, and
otherwise a distribution on the coastlines of both islands rather than a rapid diffusion on
land. Nevertheless, we also observe that there is no rapid growth along the coastlines. This
can be explained due to the slight decrease in the growth factor λ.

Note that in all cases, the carrying capacity represents the limit value the solutions may
attain. By performing further steps in the evolution process, it can be numerically verified
that the wave profiles evolve towards the stationary state whose value is given by the carrying
capacity.

5.2 Convergence Analysis

This section now elucidates the convergence of the Strang splitting method applied to the
initial boundary value problem (2.5). In the sequel, we consider the two arbitrarily shaped
islands, Ω̃3, as in figure 5.9.

First, remark that it is hardly possible to compute an analytical solution for problem
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(a) Solution after M = 120 time steps.

(b) Solution after M = 240 time steps.

(c) Solution after M = 360 time steps.

(d) Solution after M = 480 time steps.

Figure 5.10 Solution vector visualised with ParaView [13] on mesh with N = 6474 degrees of
freedom.
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(a) Solution after M = 360 time steps.

(b) Solution after M = 480 time steps.

(c) Solution after M = 600 time steps.

(d) Solution after M = 720 time steps.

Figure 5.11 Solution vector with a minuscule diffusion coefficient visualised with ParaView [13]
on mesh with N = 6474 degrees of freedom.
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(2.5), not even in one spatial dimension, see [4]. Visually, I indeed do obtain the proclaimed
travelling wave solutions, where I refer to figure 5.10. Now I aim at quantifying the conver-
gence of our numerical scheme. To this end, I consider the initial boundary value problem
(2.5) on the model domain Ω̃3.

Again, I choose a constant diffusion coefficient c(t,x) = c and a constant growth factor λ.
Moreover, I choose the carrying capacity to be constant as well. As this capacity represents
the maximal limit value for the population density, I expect the solution to attain this limit
after a sufficiently long evolution. Furthermore, the same kernel g is chosen as in (5.5) with
adequate bounds to account for the non-local boundary values. Finally, the initial population
is again represented by a point load on one of the islands.

I perform three different convergence analyses. Firstly, I control the error with the mesh
size. Secondly, I govern the error in the time step sizes; and lastly, I consider the solution
by regulating both, the mesh width and the time step size synchronously, see section 6.2.8
in [7].

5.2.1 Convergence Studies for Mesh Width

I generate an initial mesh on the model domain Ω̃3, having in this case 39 degrees of freedom,
and refine it with LehrFEM++’s Mesh Hierarchy class in the namespace refinement [9].
The finest mesh has 6474 degrees of freedom. Since no analytic solution is available, I instead
refer to the solution on the finest mesh, see figure 5.12. I let the time step size be constant
(i.e. τ = 0.01), small enough to measure the discrete error in the mesh size. In figure 5.12,
the L2(Ω̃3)-norm of the difference of the solution on the considered mesh and the solution
on the finest mesh is computed; that is

(e)l :=
√
h(l)‖uN(l) − uN(5)‖L2(Ω̃3), l ∈ {1, ..., 4}, (5.6)

where uN(l), l ∈ {1, ..., 5} represents the discrete solution vector on a mesh with N(l) degrees
of freedom after 100 time steps, and where h ∈ R denotes the mesh width. Note that N(l)

is given by

N(1) = 39, N(2) = 125, N(3) = 444, N(4) = 1670, N(5) = 6474.

Also notice that we have to interpolate the solution vectors in the finite element setting
uN(l), l ∈ {1, ..., 4} onto the finest mesh with N(5) = 6474 degrees of freedom such that the
difference in (5.6) is well-defined. This is done with LehrFEM++’s MeshFunctionFE-,
MeshFunctionTransfer- and NodalProjection-functionality [9]. Concretely, this means
that we consider the solution vectors on the coarse meshes with N(l), l ∈ {1, ..., 4} degrees of
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freedom. For these we then extract the corresponding mesh functions using the MeshFunc-
tionFE-functionality. The result is transferred onto the finest mesh via MeshFunction-
Transfer. Finally, with the NodalProjection-functionality we obtain the solution vectors
uN(l), l ∈ {1, ..., 4} interpolated onto the finest mesh.
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(a) L2(Ω̃3)-norm against number of degrees of freedom N .
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(b) L2(Ω̃3)-norm against mesh size h.

Figure 5.12 L2(Ω̃3)-norm of difference of final solution after 100 time steps on meshes with
number of degrees of freedom N ∈ {39, 125, 444, 1670, 6474} with respect to the final solution on
the finest mesh with N = 6474 degrees of freedom.

We observe an algebraic convergence rate of 1.12 in terms of the number of degrees of
freedom for the Strang splitting method, and thus an algebraic rate of convergence of 2.02

in terms of the mesh size. Therefore, the error behaves asymptotically as O(N) = O(h2),
where h denotes the mesh width.
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5.2.2 Convergence Studies for Time Step Sizes

In this section, I instead govern the time step sizes to analyse the incurred error. To this
end I consider a sufficiently fine meshM3 for Ω̃3 with 1670 degrees of freedom. I consider
different number of time steps M , namely

M(1) = 10, M(2) = 20, M(3) = 40, M(4) = 80, M(5) = 160, M(6) = 320.

The time step sizes τ(l) = T
M(l)

, l ∈ {1, ..., 6} for final time T = 1 are then correspondingly,

τ(1) = 0.1, τ(2) = 0.05, τ(3) = 0.025,

τ(4) = 0.00125, τ(5) = 0.000625, τ(6) = 0.0003125.

Again, having no analytical solution at hand, I instead refer to the solution computed with
the smallest time step size τ(6) = 0.0003125. I then control the L2(Ω̃3)-norm of the difference
of the solutions uM(l), l ∈ {1, ..., 5} and the solution with most time steps, uM(6). In figure
5.13, you observe

(e)l :=
√
τ(l)‖uM(l) − uM(6)‖L2(Ω̃3), l ∈ {1, ..., 5}, (5.7)

plotted against the number of time steps M(l), l ∈ {1, ..., 5}. There is an algebraic rate of
convergence of −1.7, and thus an asymptotic behaviour of O(M−1.7) = O(τ 1.7). Theoreti-
cally, we would expect a convergence rate of O(τ 2), for the employed SDIRK method is of
order 2, and for the reaction term we have applied an exact evolution operator.

5.2.3 Convergence Studies for Mesh Width linked to Time Step
Sizes

Finally, we link the mesh sizes to the time step sizes, and control the error norm incurred
thereof.

In theory, the error norm behaves as O(h2 + τ 2). Thus, we impose a linear dependence
of mesh width to time step size. Concretely, we consider different meshes refined as above
for N ∈ {39, 125, 444, 1670, 6474} degrees of freedom. We start with M(1) = 100 number of
time steps. For l ∈ {2, ..., 5} we set

τ(l) =
τ(1)

h(1)
h(l), (5.8)

where h(l) is the mesh size for the mesh with N(l) degrees of freedom. The corresponding
number of time steps M(l) are rounded to the next integer,

M(l) = d T
τ(l)
e, l ∈ {2, ..., 5}, (5.9)
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(a) L2(Ω̃3)-norm against number of time steps M .
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(b) L2(Ω̃3)-norm against time step size τ .

Figure 5.13 L2(Ω̃3)-norm of difference of final solutions with number of time steps M ∈
{10, 20, 40, 80, 160, 320} with respect to M(6) = 320 time steps on a mesh with N = 1670 de-
grees of freedom.
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with final time T = 1.
Let me refer to figure 5.14, which illustrates

(e)l :=
√
h(l)‖uN(l),M(l) − uN(5),M(5)‖L2(Ω̃3), l ∈ {1, ..., 4}, (5.10)

where uN(5),M(5) is the reference solution on the finest mesh. Again, let me point out that the
solution on the coarser meshes uN(l),M(l), l ∈ {1, ..., 4}, were interpolated onto the finest mesh
using LehrFEM++’s functionalities as above in section 5.2.1. We conceive the asymptotes
O(N +M2) = O(h2 + τ 2), as predicted.
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(a) L2(Ω̃3)-norm against number of degrees of freedom N .
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(b) L2(Ω̃3)-norm against mesh sizes h.
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(c) L2(Ω̃3)-norm against number of time steps M .
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(d) L2(Ω̃3)-norm against time step size τ .

Figure 5.14 L2(Ω̃3)-norm of difference of final solutions with number of time steps M ∈
{100, 200, 400, 800} on meshes with N ∈ {39, 125, 444, 1670} degrees of freedom with respect to
M(5) = 976 time steps on a mesh with N = 6474 degrees of freedom.
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Chapter Six

Results

In this chapter, I will provide the visualised results for the evolution of the population density
from 200000 years ago up to 15000 years ago, according to the parameters as in the first
approach in section 6.1.1. Let me refer to figure 6.1 for the visualisation of the triangular
meshM on our domain Ω.

Figure 6.1 Triangular meshM of Ω generated with Gmsh [5]. Number of degrees of freedoms:
15463.
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6.1 Parameters

In this paragraph, I discuss the choice of parameters in the implementation.

6.1.1 First Approach

Firstly, I used a constant diffusion coefficient, neglecting the earth’s topography. In order to
account for high mountain chains, impeding the dispersal of population, the diffusion coeffi-
cient might be chosen piecewise constant only, see paragraph 6.1.2 on the second approach
below.

Secondly, I chose a constant growth factor λ. Here again, one could choose a time-
dependent growth factor, to respect differences in growth rates per epoch. However, this is
more difficult to take into account, due to the sparsity of data for the concerned time epoch.

Thirdly, the carrying capacity plays an important role in my model. In my case, the
carrying capacity relies on the dispersal of the Homo Sapiens according to [17]. Initially, I
attributed on each degree of freedom a low carrying capacity. Then, for each epoch, I put a
point load onto the surface coinciding with the location of the humans at this time. I let this
point load diffuse over a certain area, such that visually the carrying capacity is augmented
in the area where the humans assembled in this epoch according to [17]. As time evolves, I
added up all the contribution of the carrying capacity, yielding a final carrying capacity for
the last time steps. The values of the capacities range from 0 to 1.

Fourthly, for the non-local boundary value, I chose a decaying kernel depending on the
distance between two coastlines. Let me refer to section 2.1. Specifically, the kernel g :

∂Ω× ∂Ω→ R is chosen as

g(x,y) =

 1
‖x−y‖2+1

, if 5 ≤ ‖x− y‖ ≤ 30,

0, elsewhise.
(6.1)

Note that I have chosen lower and upper bounds for the decaying function kernel. The
bounds are chosen in accordance to the domain Ω. I intended to model sea crossings of
near-by boundaries, as well as travels along coastlines. Yet, it also makes sense to impose a
lower bound, for it is reasonable to suggest that people prefer to travel on land to close-by
sites on the same coast instead of directly taking the boat. However, note that this does not
mean that traveling along the same coastline is suppressed. Indeed, all coastlines beyond
the lower threshold can be reached.

And finally, the initial population is set to a small point load located in Eritrea 200000

years ago.
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6.1.2 Second Approach

In a second approach, I modified the diffusion coefficient in such a way as to account for high
mountain ranges on the earth’s surface complicating the diffusion of the population. There-
fore, instead of a constant diffusion coefficient, I now chose a piecewise constant coefficient
depending on the coordinates c(t,x) = c(x), t ∈ [0, T ], x ∈ Ω. The other parameters were
left unchanged.

Due to the fact that the differences in the two approaches are visually negligible - you
may only perceive a slight decrease in the dispersal over the mountain ranges - I restrict the
provision of the result to figure 6.2, visualising the first approach.

6.2 Visualisation

With the choice of parameters according to the first approach in section 6.1.1 above, we
obtain the travelling wave fronts on the earth’s surface in figure 6.2. Clearly, the results are
of a qualitative nature due to sparse availability of data from pre-historic times.
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(a) Population density 200000 years ago. (b) Population density 150000 years ago.

(c) Population density 130000 years ago. (d) Population density 100000 years ago.

(e) Population density 70000 years ago. (f) Population density 65000 years ago.

(g) Population density 50000 years ago. (h) Population density 45000 years ago.

(i) Population density 25000 years ago. (j) Population density 15000 years ago.

Figure 6.2 Solution vector visualised with ParaView [13] on mesh with N = 15463 degrees of
freedom.
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Chapter Seven

Conclusions

We have seen that the Fisher equation is fairly well suited to model population dynam-
ics. Equipped with non-local boundary condition, we were able to work on a disconnected
domain, where we have taken into account the dispersal over "straits".

The numerical scheme based on finite element methods yields a beautiful variational
problem. The Strang splitting method is fairly well suited. For it allows to employ a time
stepping scheme for the diffusion and the reaction term separately. Consequently, we were
able to use an L(π)-stable method of second order for the diffusion term, as well as the exact
evolution operator for the reaction term, for the reactive part of Fisher equation coincides
with Verhulst’s logistics equation, whose solution is analytically computable.

The convergence studies assert an asymptotic behaviour of our numerical scheme as
O(h2 + τ 2), where h is the mesh width and τ the time step size. This coincides with the
theoretical prediction for the method we have employed. Moreover, we have also observed
travelling wave fronts on several bounded domains, in each of which, given a compactly
supported initial datum, the solutions propagate at finite speed.

The choice of parameter was set such that the result coincided visually with the desired
output. Especially the carrying capacity maps were assembled in such a way as to adhere
to the agreement of paleontologists’ view on the dispersal of our ancestors. We even accom-
plished to account for the topology on the earth’s surface, by choosing a piecewise constant
diffusion coefficient.

To improve efficiency of our method, we could make use of Quad Trees for a more efficient
assembly of the non-standard Galerkin matrix for the second part of the non-local boundary
term (4.3). Apart from this, instead of the employment of the Strang splitting method, a
semi-implicit method could be deployed, such as a Rosenbrock-Wanner method.
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APPENDIX

The implementation can be accessed at
https://github.com/craffael/lehrfempp/tree/master/projects/FisherKPP. The main simula-
tion on the earth constitutes of the files strangsplitting.h, strangsplitting.cc and strangsplit-
ting_main.cc.

Furthermore, all model problems discussed in Chapter 5 have a corresponding file named
modelproblem_*_main.cc. Clearly, these rely on the previously mentioned files strangsplit-
ting.h and strangsplitting.cc for the underlying numerical schemes.

Moreover, there are three files for the convergence analyses. These are implemented in
the files convergence_*_main.cc. The plots are then generated with the Matlab scripts
provided in the folder convergence_scripts.

Lastly, note that all underlying meshes used in the main simulation, in the model prob-
lems and in the convergence studies can be accessed in the folder meshes.
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